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BEFORE YOU START

1.1. Preface

A few years ago, when I first looked at the wonderful world of 3D
modeling, I started my long search for the right tool.
It was a really exhausting research: no software really suited to
my needs because of either the unfriendly interface or the
extreme complexity, or the bad guides or the poor results.
I was about to give up. Maybe I’ll never find the right software
that would allow me to go on by myself and create the 3D
models of my own projects without asking for other professionals’
help (costing a lot of money, often out of budget).
However, someone showed me Blender as the solution to my
problems. At the beginning I was skeptical, due to the bad
experiences mainly caused by the (sometimes partial) study of
other open source or free software.
It is a common opinion that “free” is synonymous with poor,
incomplete, unprofessional.
Blender immediately turned out something wonderful, extremely
complete and professional.
Its graphic interface seamed to me linear and well organized,
perfectly clear and understandable, contrary to what is said by
some users.
Specially since newer versions kept on improving over and over.
Its completeness and potential encouraged me so much that I
purchased all English and Italian educational materials around
and, not happy, I took private lessons.
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I almost immediately felt my hardware had to be upgraded and
then I bought all latest gen components that allow me to push
the software towards higher performances.
Meeting my friend and colleague Francesco Andresciani, which
inspired me this extensive work, showed me a new direction: a
series of successful publications that make me proud even
today. Then I had the idea and the desire to write the guide I
always wanted to read.
The complete and full of practical examples handbook I wanted
to have on my bookshelf and on which I wanted to learn
Blender.
A different guide from the others, far from the index-topic
scheme, a path whose secrets will grow with me.
Blender is an ever growing software, something open you can
test and study on, reaching new goals every time.
My research goes on, but in the same software environment
now. Daily study, exercises and the discovering of new features,
plugins and techniques encourage me to continuous
improvement.
I hope that the following pages could be for you what I
unsuccessfully looked for and what could have doubled the
knowledge in half the time.
All my best wishes for your work!

Andrea Coppola
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1.2. Introduction

This guide is obviously divided in 5 main volumes and annual
updates, depending on the new Blender releases.
This guide can be considered valid for all the versions of Blender
2.6x, 2.7x, and next 2.8x and 2.9x.
In the first volume we will discuss basic topics from general
information to system configuration, to the customization of work
environment, to the structure and the functionality of the user
interface (UI), to basic and advanced modeling tools (modes,
transform tools, modifiers).
In the second volume we will explore in depth the two main
render engines (Blender Render e Cycles Render), the lighting,
the materials in both the engines, the manifold nodes techniques
and the camera framing.
The third volume will focus on the physic simulations (fluids,
smoke and flames, volumetric effects, rigid and soft bodies
dynamic, cloche and force fields), on the particles systems and
on the Compositing of final images.
The fourth volume will be entirely dedicated to animations,
rigging and armature’s inverse kinematic, Motion Tracking,
Sculpting and audio-video editing.
Finally, the fifth volume is dedicated to advanced Grease Pencil,
advanced Compositing and Game Engine.
Please refer to future publications for other volumes on further
topics and new features.
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Blender is a really sophisticated and detailed suite, it is almost
impossible to deeply know and describe all features and
techniques, specially the most advanced ones.
I wish this huge effort could became a Landmark but also a
starting point for all Blender users, professionals, CG fans and,
why not, amateurs and beginners.
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1.3. Blender history

At the end of 90’s Blender started to be distributed for free and it
gathered a tremendous amount of interest from 3D graphic fans.
Blender was first created in 1995 as an in-house 3D toolset of the
Dutch animation studio NeoGeo, replacing the too old previous
one, under the artistic direction and internal software
development of Ton Roosendal.

fig. 1 One of the first Blender release, the 1.60

In 1998 Ton himself decided to found a new company called Not
a Number (NaN) to further develop Blender as the first great
open source 3D modeling software.
In 2000 NaN secured financing of € 4.5M which enabled NaN to
rapidly boost Blender development, reaching soon 250.000
registered users.
However in the following years, on the edge of bankrupt with
NaN, Ton Roosendal founded the non-profit organization
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BlenderFoundation; since then it continues developing and
promotingBlender as the greatest community-based open
source project ever.
Year after year the Blender Foundation developed and released
for free several animation movies like Sintel and Caminandes.

fig. 2 Durian Project: Sintel

The new experimental feature film “Gooseberry Project - Cosmos
Laundromat” is now being developed.
You can watch
www.blender.org.

them

on

YouTube

or

download

from

Blender features are many: from 3D modeling to sculpting, from
compositing to photo-realistic or cartoonish rendering, from
animation to visual effects, from game development to
programming.
From the quality point of view Blender has absolutely nothing to
envy to other most known commercial software.
Its versatility, easy to use and high quality performances make of
Blender an effective competitor, open source besides.
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The non-stop development and the opening to external
programmers allow Blender to be constantly improved, updated
and corrected.
The new render engine Cycles, considered the basic render
engine of this wonderful suite, is unquestionably one of the best
unbiased render engines, that type of engines which use, at the
cost of render times, an algorithm that simulate the real lighting
behavior, creating extreme photo-realistic renders.
But what does open source mean?
This term refers to any software whose programming code is
open to any programmers who want to contribute to its
development.
This means Blender has a free license, is cross-platform and runs
equally well on Linux, Windows and Macintosh computers.
Blender is the future of the 3D Artist job.
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1.4. About Free Software and GPL1

When one hears about “free software”, the first thing that comes
to mind might be “no cost”. While this is typically true, the term
“free software” as used by the Free Software Foundation
(originators of the GNU Project and creators of the GNU General
Public License) is intended to mean “free as in freedom” rather
than the “no cost” sense (which is usually referred to as “free as
in free beer” or gratis). Free software in this sense is software
which you are free to use, copy, modify, redistribute, with no
limit. Contrast this with the licensing of most commercial software
packages, where you are allowed to load the software on a
single computer, are allowed to make no copies, and never see
the source code. Free software allows incredible freedom to the
end user. Since the source code is universally available, there
are also many more chances for bugs to be caught and fixed.
When a program is licensed under the GNU General Public
License (the GPL):
−
−
−
−

You have the right to use the program for any purpose.
You have the right to modify the program and have access
to the source codes.
You have the right to copy and distribute the program.
You have the right to improve the program, and release your
own versions.

In return for these rights, you have some responsibilities if you
distribute a GPL program, responsibilities that are designed to
protect your freedoms and the freedoms of others:
−

You must provide a copy of the GPL with the program, so
that recipients are aware of their rights under the license.

1From www.blender.org
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-

-

You must include the source code or make the source code
freely available.
If you modify the code and distribute the modified version,
you must license your modifications available under the GPL
(or a compatible license).
You may not restrict the licensing of the program beyond the
terms of the GPL. (you may not turn a GPL program into a
proprietary product.)

The GPL only applies to the Blender application and not the
artwork you create with it; for more info see the Blender License
policy on www.blender.org.
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1.5. The Method

Discuss all the topics of the Blender suite is a cyclopean venture,
probably also because of its constant and continuous updating
and new feature releases.
However, in this volumes, I tried to sum up all Blender features
and explain them as easily and fluently as possible, covering
(almost) every setting and tool, but also showing practical
examples that allow you to start working right away.
Users are highly recommended to pay attention to the exercises
starting from the beginning of the chapters regarding the basic
knowledge, which often refer to practical aspects.
We will always repeat the command shortcuts, the working
modes, windows and panels from which start a command, in
order to let the visual memory gradually help you to learn the
main software features.
You will also find some symbols at the beginning of certain
paragraphs which means:

Exercise symbol (inserted in a grey box);
Definition or tip;
Note icon (bold typed in a grey framed box);

As we love to repeat, Blender is a complex but not difficult suite,
therefore you will need constant practice.
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Knowing how it has been programmed and how it is meant to
work is the key for the optimal understanding and use.
Keep this little advices in mind before you start this long and
winding journey.
We truly believe (and we wish) that 3D graphic and the power of
Blender will become a growing passion for you.
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1.6. Convention used in this volumes

In this volumes, we’ll use the following conventions:

LMB

Left Mouse Button

RMB

Right Mouse Button

MMB

Middle Mouse Button

MW

Mouse Wheel

SHIFT

SHIFT key on the keyboard

ALT

ALT key on the keyboard

CTRL

Control key on the keyboard

TAB

TAB key on the keyboard

SHIFT+C

Key combination (ex. Shift and C)

ENTER

ENTER key on the keyboard

7 NUM

7 key on the numpad

F1 - F12

Function key from F1 to F12

SPACEBAR

SPACEBAR key on the keyboard

BACKSPACE

BACKSPACE key on the keyboard
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1.7. How to install Blender

ww.blender.org
You can download Blender for free from ww
where you can choose the Windows, Mac OSX orr LLinux version.

fig 3 www.blender.org homepage

From the Download section all you have to do iss tto choose your
platform and download the installation file. This volume
vo
refers to
version 2.7x, and the new features will be ana
nalyzed on the
upgrade volumes.

Windows installation
On Windows systems you can download either the
he Installer file or
the *.zip folder (64bit is preferred if supported).
When you run the Installer (*.msi) you’ll be ask
sked to set the
destination folder and the *.blend files relation. Y
You must have
administrator privileges to install Blender on your sys
ystem.
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With the *.zip option Blender should run out of the box, without
installation procedure. To use Blender, just unpack the archive
you downloaded and start Blender.
Mac OSX Installation
On Mac systems just unpack the blender.app folder into the
archive you downloaded and drag it into the Application folder.
Otherwise you can run Blender directly from the packed folder.

GNU/Linux installation
On Linux systems you can download the *.bz2 archive to be
unpacked.
The installation file suits most recent GNU/Linux distributions and
you can directly run Blender from the unpacked folder.
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1.8. Settings and customization

One of the main feature of Blender is its flexibility and fully
customizability to suit all your needs, you system hardware
performances and you personal habits without any specific
patch.
Besides the UI customization (we’ll discuss it later), from the
System Preferences window (File – User Preferences or
CRTL+ALT+U) you can adjust many settings according to your
system, your aesthetic taste, the mouse use, the controls, the
visualization, the shortcuts and the
Add-ons. Let’s open the User Preferences window.
It appears as a stand-alone window and it is the only case in
Blender because it is designed to allow you to view all relevant
options and tools at a glance without pushing or dragging popup boxes around.

1.8.1. User Preferences
In the User Preferences windows the available options are
grouped into seven tabs, as shown below:
Interface (where you define some settings on the interface);
-

Interface (change how UI elements are displayed and how
they react);
Editing (control how several tools will interact with your input);
Input (customize how Blender reacts to the mouse and
keyboard as well as define your own keymap);
Add-ons (manage Blender’s Add-ons and plugins);
Themes (customize interface appearance and colors);
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-

File (configure auto-save preferences and set default file
paths for blend-files and more);
System (set resolution, scripting console preferences, sound,
graphics cards, and internationalization).

fig. 4 How to open the User Preferences editor

A)

Tab Interface

In this section you can manage the UI elements.
Under Display you can check/uncheck this options:
-

Tooltips when enabled, a tooltip will appear when your
mouse pointer is over a control;
Python Tooltips displays a property’s python information
below the tooltip;
Object info display the active Object name and frame
number at the bottom left of the 3D View;
Large Cursors use large mouse cursors when available;
View Name displays the name and type of the current view in
the top left corner of the 3D View;
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-

Playback FPS shows the frames per second screen refresh
rate while an animation is played back;
Global Scene forces the current scene to be displayed in all
screens;
Object Origin Size sets the diameter of selected 3D Object
centers in the view port;
Display Mini Axis shows the mini axis at the bottom left of the
viewport, while the two settings below define their dimension
and brightness when enabled.

fig. 5 Interface tab in the User Preferences editor

Under View Manipulation you can check/uncheck this options:
-

Cursor Depth use the depth under the mouse when placing
the cursor;
Auto Depth improve view pan, rotate, zoom functionality;
Zoom to Mouse Position when enabled, the mouse pointe
rposition becomes the focus point of zooming instead of the
2D window center. Helpful to avoid panning if you are
frequently zooming in and out;

19

-

-

Rotate Around Selection the selected object becomes the
rotation center of the viewport;
Global Pivot lock the same rotation/scaling pivot in all
3DViews;
Auto Perspective automatically switch to perspective
projection when moving from Orthographic Top/Side/Front
view to User view;
Smooth View length of time the animation takes when
changing the view with the numpad;
Rotation Angle rotation step size in degrees, when
4NUM,6NUM, 8NUM, or 2NUM are used to rotate the 3D View.

Under 2D Viewport you can set this options:
-

Minimum Grid Spacing the minimum number of pixels
between grid lines in a 2D viewport;
TimeCode Style format of Time Codes displayed when not
displaying timing in terms of frames.

In the top right corner you can enable/disable the Manipulator
(edit tool to translate, scale and rotate objects in the 3D
viewport) and set its visual parameters.
The Menus options allow you to have the menu open by placing
the mouse pointer over the entry instead of clicking on it.
Pie Menu options control the settings of this selection tool (must
been abled from the Add-ons tab).
Show Splash simply enable/disable the splash screen on Blender
startup.
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B)

Tab Editing

These preferences control how several tools will interact with your
input.
-

-

-

Link Material To define the way materials are applied to
objects;
New Object set the insert rules of a new object into the
scene. You can align it to World or View coordinates and
set/unset Edit Mode as the default mode for new objects;
Undo allows you to manage the number of undo steps
available;
Grease Pencil controls the starting parameters of the pen
tool(radius, smoothness, default color…) you can use to draw
directly in the 3D viewport;
Allow Negative Frames under Playback enable/disable the
possibility to set negative frames on the timeline.

fig. 6 Editing tab in the User Preferences editor

Under Keyframing you find the following check boxes and
controls:
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-

-

Visual Keying enable/disable the keyframes visibility;
Only Insert Needed will only insert keyframes if the value of
the property is different;
Auto Keyframing enables Auto Keyframe by default for new
scenes;
Only Insert Available will only add keyframes to channel FCurves that already exist;
New F-Curve Defaults controls the mathematical behavior of
the new F-Curves;
XYZ to RGB set the same color for X, Y or Z animation
curves(location, scale or rotation) as the color for the X, Y and
Z axis;

When enabled, Release Confirms check box under Transform
allow you to confirm a transformation (started with a drag-anddrop LMB action) just by releasing the LMB.
Sculpt Overlay Color allows the user to define a color to be used
in the inner part of the brushes circle when in Sculpt Mode.
The last section Duplication Data allows the user to decide
which data of the original object will be transferred to the
copied ones.

C)

Tab Input

In the Input preferences, you can customize your keymap.
From the Preset drop-down menu you can assign to Blender the
same keymapping from other 3D software like 3DStudio Max or
Maya. Clicking on + or – buttons you can add a custom preset
or delete an existing one.
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Checking the Emulate 3 Button Mouse options Blender will
emulate the functionality of a 3 button mouse even on an
Apple mouse or a 2 button laptop touchpad, according to the
following key combinations:
3 buttons mouse
LMB
MMB
RMB

2 buttons mouse
LMB
ALT + LMB
RMB

Apple mouse
LMB
CMD + LMB
CMD + LMB

Continuous Grab allows the drag-and-drop transformations
(such as grabbing or panning a view) to continue over the
viewport limits by warping the mouse within the view.
Drag/Tweek Threshold defines number of pixels that a User
Interface element has to be moved before it is recognized by
Blender as a movement.
As you may have noticed, the mouse buttons input settings are
set by default as the opposite of the most common commercial
software. First of all, the selection with the RMB instead of the left
one.
It is a personal choice, but I recommend to switch to left button
selection as the User Preferences window allows us to do that. So
in the Input tab go to the Select With section and select Left
(colored in blue when selected) to enable left mouse button
(LMB) selection.
Double Click set the speed of double clicking (in ms).
Emulate NUM tells Blender to treat the standard number keys as
Numpad keys if you have a keyboard without a Numpad (e.g.
on a laptop).
Orbit Style sets how Blender works when you rotate the 3D View
by default when holding MMB. If you are familiar with Maya or
Cinema 4D you may want to set Turntable.
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fig. 7 Input tab in the User Preferences editor

Zoom Style controls how Blender performs zoom in and zoom out
actions when the CTRL+MMB combination is used, choosing
among
Dolly, Continue and Scale.
Invert Zoom Direction inverts the Zoom direction for Dolly
and Continue zooming.
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Invert Wheel Zoom Direction inverts the direction of the mouse
wheel zoom.
NDOF Device sets the sensibility of a 3D mouse.
With the Keymap Editor you can edit each keymap for every
single windows in Blender.
On the right side of the Input tab you can reset or edit all the
shortcuts used in Blender.

D)

Tab Addons

fig. 8 Add-ons tab in the User Preferences window
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o
In the Add-ons tab you can easily manage secondary options,
which are not enabled in Blender by default, using the sea
arching
filter or the categories list. New features may be added a
as well
with Install From File… button.

E)

Tab Themes

earance
The Themes tab allows you to customize interface appea
and colors, windows, border colors, backgrounds,, cells...
Elements are grouped by categories in the list on the le
left. You
can also click on Reset to Default Theme.

fig. 9 Themes tab in the User Preferences editor
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F)

Tab Files

The File tab allows you to configure auto-save pre
references and
set default file paths for blend-files, rendered image
ges, and more.
In the File Paths section you can specify the locati
tions for various
external files such as fonts, textures, render output,
ou
sounds,
scripts, temporary and cache files and more.
On the right you can find the Save & Load sectio
ion where to set
the rules of loading and saving files (relative pat
aths, *.blend file
compression, load external UI, filter file extensio
sions and show
thumbnails in the internal browser).

fig. 10 File tab in the User Preferences editor

You can also control:
Save Version number of versions created forr the same file
(forbackup);
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Recent Files number of files displayed in File - Open Recent;
Save Preview Images enable the previews of images and
materials in the File Browser.
In the Auto Save section:
Auto Save Temporary File enable Auto Save (create a temporary
file);
Timer is the time to wait between automatic saves.

G)

Tab System

fig. 11 System tab in the User Preferences window
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The System tab allows you to set resolution, scripting console
preferences, sound, graphics cards, and internationalization
(languages).
Under General:
-

-

DPI sets the value of the screen resolution which controls the
size of Blender’s interface fonts and internal icons shown;
Virtual Pixel Mode allows you to select global scaling. While
the DPI only scales the interface, this will scale line width,
vertex-size. This is intended for hi-dpi monitors;
Frame Server Port TCP/IP port used in conjunction with the IP
Address of the machine for frame server rendering;
Console Scroll backsets the number of lines, buffered in
memory of the console window.

In the Sound section you can set the audio output device
(OpenAL, SDL or None), the audio channel count (Mono, Stereo,
4 Channels, 5.1 Surround, 7.1 Surround), the number of samples
used by the audio mixing buffer (512 , 1024 , 2048, 4096 , 8192,
16384, and 32768), the audio sample rate, which is the audio
sampling frequency (44.1 Khz,48 Khs, 96 Khz and 192Khz) and the
audio sample format in bits (32 float, 8 Unsigned, 16 Signed, 24
Signed, 32 Signed, 32 Float, and 64 Float).
Compute Device will set the compute device used by the
Cycles Render engine. When set to Noneyour CPU will be used
as a omputing device for Cycles Render Engine. When set to
CUDA you will be able to use your compatible Nvidia CUDA
enabled graphics card it to render with the Cycles Render
Engine. It is highly recommended to use graphics cards when
possible.
In the OpenGL section you’ll be able to set options like Clip
Alpha (from 0 to 1) or Mipmap (scale textures for 3D View using
Mipmap filtering).
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s
Other options are Anisotropic Filtering and VBOs (which speeds
up the viewport rendering acting on the vertex arrays), and
a
the
Window Draw Method which fit the graphics card driverr ssettings
(Automatic)or allows to choose other methods.
Text Draw Options enable interface text anti-aliasing.
In the Textures sections, the Limit Size control limits the ma
aximum
resolution for pictures used in textured display to save me
memory,
while the Time Out value indicates the time since last acce
cess of a
GL texture in seconds, after which it is freed.
In the Sequencer/Clip Editor the Prefetch Frame value se
sets the
number of extra-frames over the video playback. The Memory
M
Cache Limit is the upper limit of the sequencer’s m
memory
cache(megabytes).
Solid OpenGL Lights are used to light the 3D View, mostly
ly during
Solid view.
Custom Weight Paint Range allows the user to customiize the
default color ramp (red-yellow, blue-green) Blender use
u
to
visualize how much a bone deforms the mesh of a charact
cter.
International Fonts allows the user to use a different font
nt set in
order to translate either the UI or the tooltips into any
ny other
supported language (we strongly discourage to use a lan
nguage
other than English).

Once you finished customizing user preferences, you
yo can
save your settings by clicking on the Save User Settings
S
button.
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1.8.2. System requirements
Blender is a very light software, but it has to be supported by a
powerful hardware to ensure high performance, specially with
complex calculations and heavy scenes. We show below a
basic and a recommended configuration regardless the used
platform.
Configurations are update to 2015.
Basic configuration:
-

CPU Intel i5
RAM 4GB
HD 500GB
Graphic card with 2GB RAM and 512 Cuda Core

Recommended configuration:
-

CPU Intel i7 or above
RAM 16GB
HD SSD 512 GB
Graphic card with 4GB RAM and 1500 Cuda Core

But what is Cuda Core?
Modern graphic cards, specially the professional ones, are real
computers, which replace CPU in the graphic calculations.
Graphic card processor is called GPU (Graphic Processor Unit)
and is equipped, as well as the CPU, with logic units.
Core refers to these units, real processors inside the hardware
component, which manage the calculations individually,
increasing their rate and speed.
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GPUs work exactly like CPUs but, even if each single GPU
U Core is
slower compared to CPU’s, GPU can manage a higher n
number
of logic units.
As an example, Quad Core means a CPU with 4 logic
gic units
(Cores). The latest graphic cards, like Quadro series, has
as up to
4000 Cores!
However not all the graphic cards are suitable for use in Blender.
Ble
Before you purchase a graphic card, make sure the GPU is
compatible with CUDA Core.
We can suggest Nvidia GTX 700, 800 and 900 series or the
advanced
Titan and Quadro series.

fig. 12 the new graphic board Nvidia GTX 1080
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If your system is equipped with such a card, you
u better choose
it as
stem tab of the
Compute Device by selecting CUDA in the Syst
User Preferences window (lower right corner) and
a
saving you
settings by clicking on the Save User Settings butto
tton.
ectly managing
Blender also supports multi-cards settings direc
them from the Compute Device section of the User
Us Preferences
window. If more than one cards is installed, yo
ou can choose
the right combination (e.g. Device 1 + Device 2).
).

IMPORTANT TIP: best performances are granted with
identical graphic cards, same model, sam
me chipset and
access speed, same CUDA Cores and sa
ame RAM. Any
difference, especially if significant, may
y cause worse
performance than one card.

fig. 13 CUDA enabling in the System User Preferences
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Saved settings will maintain every time Blender is started.
If you changed the main windows layout, you can also save your
UI customizations as default start-up file.
Go to File – Save Startup File (or CTRL+U) and confirm your
choice. From now on Blender will start with your own settings.
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1.9. Online Resources

You can find tons of information and tutorials about Blender all
over the web. Sometimes it is good quality stuff, sometimes not.
As it is open source, everyone can contribute to its development,
however users must be able to get the best from online
materials.
Internet is full of dedicated sites and tutorials, some of them very
useful and well done.
Here is a short list of some Blender-related websites from which
extract some more info, complementary to this Guide:
- www.blender.org(official Blender website)
- www.blenderfoundation.com(official
website)

Blender

Foundation

- www.blenderhighschool.net(educational website from this
guide’s author)
- www.blenderartists.org(the biggest Blender forum)
- www.blenderguru.com(Andrew Price’s website where you
can find a lot of precious tips and high quality tutorials)
- www.bledtuts.com(high quality tutorials)
- https://cgcookie.com/learn-blender/
content website)

(educational

and

- www.blendswap.com(Blender website from which you can
download a lot of models and assets for Blender)
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fig. 14 website www.blenderhighschool.it
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2
BASIC OPERATIONS

2.1. Editors and Interface structure

Before starting to jump through the Blender windows, it is useful
to clearly understand how they work, which elements, buttons,
areas, panels and input data areas they are made of.
We must gain the full control of these windows, also named
Editor, and understand how they can be placed, erased, splitted
and resized. In one word: customized.

fig. 15 3D view Editor

Blender has several Editors with common features each.
We will describe them one by one.

2.1.1. Header
All editors have a Header, a strip with a lighter gray background
containing icon buttons.
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Each Header has an icon drop down menu on the left corner
which allows to choose the window (or Editor) type. To change
the features of the current window simply choose an icon on the
drop down menu.

fig. 16 Header

All editors have a Header, a strip with a lighter gray background
containing icon buttons.
Each Header has an icon drop down menu on the left corner
which allows to choose the window (or Editor) type. To change
the features of the current window simply choose an icon on the
drop down menu.

fig. 17 drop down menu

To move a header from top to bottom or the other way round,
simply click on RMB on it and select the appropriate item from
the pop-up menu (Flip to Bottom or Flip to Top). To gain some
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extra horizontal space in the header you can choose Collapse
menus.
You can also set the active window to full screen (or the way
back) by choosing Maximize Area or Tile Area (CTRL+UP-Arrow).

fig. 18 Header's visualization options

2.1.2. Work Space

fig. 19 work space

The work space is the main area of a window, the place where
the magic happens.
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Not every window has a work space (such as the Properties
window).
Sometimes, such as in the 3D Viewport, the work space can be
further divided and show other related sidebars.

2.1.3. Sidebars

fig. 20 the two sidebars of the 3D Viewport (Tools and Properties Bar)

Sidebars are special vertical areas at the right and/or left corner
of specific windows (some window could have one, some other
two, some other none), which contains additional tools and
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information and can be easily visualized/hidden with the same
shortcuts (T for the left bars, N for the right ones).

2.1.4. Regions
Regions further subdivide a bar.

fig. 21 upper region in the Tools Shelf
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2.1.5. Tabs
atures of
Tabs are side “flaps” used to group specific tools and feat
one or more regions based on a common topic.

fig. 22 Tools tab in the Tools Shelf

2.1.6. Panels

fig. 23 Transform panel in the Tools Shelf

p
The smallest organizational unit in the user interface is a panel,
which can be collapsed to hide its contents by clicking
g on its
upper left black arrow (or its header), or you can chang
nge the
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order of panels by clicking and dragging on the
e handle in the
upper right corner of a panel’s title.

fig. 24 dragging of the Edit panel in the Tools Shelf

fig. 25 pinning a panel
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Often it is desirable to view panels from different tabs at the
same time. This has been solved by making panels with Pin
option. A pinned panel remains visible regardless of which tab
has been selected. You can pin a panel by clicking SHIFT+LMB
on its header, or by clicking RMB on the header and choosing
Pin.

2.1.7. Resize windows
You can resize areas by dragging their borders with LMB. Simply
move your mouse cursor over the border between two areas
until it changes to a double-headed arrow, and then click and
drag.
You can maximize an area to fill the whole application window
with CTRL+UP-Arrow (or CTRL+DOWN-Arrow).

2.1.8. Split or Join windows
You can manage the windows layout by splitting existing
windows and then adjust its dimensions and type according to
your needs.
In the upper right and lower left corners of a window are the window
splitter widgets, and they look like a little ridged thumb grip. It both
splits and combines window panels. When you hover over it, your
cursor will change to a cross. LMB and drag it inward to split the
window vertically (moving right/left) or horizontally (moving
up/down).

To join the current window with the one above it, hover the
mouse pointer over the window splitter. When the pointer
changes to a cross, LMB click and drag up to begin the process
of combining.
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fig. 26 splitting a window

To join the current window with the one above
ve it, hover the
mouse pointer over the window splitter. When
en the pointer
changes to a cross, LMB click and drag up to beg
egin the process
of combining.
The upper window will get a little darker, overlaid
id with an arrow
pointing up. This indicates that the lower (current)
t) area will “take
over” that darkened area space. Release the LMB
B to join.
If you want the reverse to occur, move your mous
use cursor back
into the original (lower) area, and it will instead
d get the arrow
overlay.
t right or vice
In the same way, windows may be merged leftt to
versa.
In order to merge two areas, they must be the sam
me dimension in
the direction you wish to merge. For example,, if
i you want to
combine two areas that are side-by-side, they mus
ust be the same
height. If the one on the left is not the same as the
th one on the
right, you will not be able to combine them horizon
ntally.
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fig. 27 Joining two windows

2.1.9. Buttons and controls
Inside the windows you can find several buttons, icons,
s, boxes
and other controls used to assign numeric values to sp
specific
actions, to apply tools or simply to make choices. Let’s
’s check
them in depth.
a) Operation Buttons
Operation Buttons are simple active boxes, which sstart a
command on a mouse click.

fig. 28 operation buttons

Operation Buttons are simple active boxes, which sstart a
command on a mouse click.
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b) Switches
Switches are similar to buttons but are grouped in two or more
elements. When one is clicked the others are automatically
disabled.

fig. 29 switches

c) Drop down menus

fig. 30 drop down menu

Clicking on a drop down menu (marked with two
tw little bright
arrows) will show a list of options to choose from.

d) Check boxes

fig. 31 check box

Check boxes simply enable/disable a specific optio
tion.
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e) Counters

fig. 32 counter

With counters you can specify a value clicking on its center or
increase/decrease the current value by using the side arrows.

f)

Sliders

fig. 33 sliders

With sliders you can specify a value clicking on its center or
increase/decrease the current value by sliding the bar to
right/left. The main difference between Sliders and Counters is
that sliders can only operate into a range between a min and
max value.

g) Text fields

fig. 34 text field

Text fields allow you to insert alphanumeric strings fro example to
name objects.
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h) Color Picker (palette)

fig. 35 color picker (palette)

Color Picker (or palette) is a tool witch allows you to insert
numeric values to define a specific color.
A typical example is when you has to define the color of a
material.

i)

Icons

fig. 36 icon
Icons, as seen previously, usually activate a drop-down menu,
rather than text fields or other buttons. One example is the icon
of the header that determines the window type.
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2.1.10. Mathematical functions in Counters and Sliders
In the field dedicated to the numerical values entries of the
Counters and Cursors you can also enter mathematical
functions. The Blender calculation engine is able to calculate the
inserted formulas.
For example by entering the value 0:20 + 1.30 will be
automatically calculated and displayed the value 1.50m (in
meters if it is set, as we shall see later).
Similarly you can use the symbols – (minus), / (divided), * (times),
^ (raised), log (x) (logarithm), sin, cos, tan (sine, cosine and
tangent), abs (x) (absolute value) and other mathematical
functions.

2.1.11. The – (minus) symbol
During transform operations that we will see below (move, rotate
and scale), minus is used in case of negative transformation,
which means opposite to the positive direction of the axis and
the absolute counter-clockwise rotation. The symbol – (minus)
can also be inserted below the absolute value, so you do not rerun the operation again in case of error or omission.
For example, to translate along the x-axis of 2 meters in the
negative direction (according to conventional orientation) you
can type “– 2” as well as “2 –”.

2.1.12. Decimals
The decimal values are separated by default by the period (.),
for example 12.3.
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The zero at the end is not necessary (12.3 = 12.30).
Also the zero at the beginning can be suppressed for non-integer
values smaller than 1. For example “0.4” can simply be typed
“.4”.

2.1.13. Units
It will be shown later how to set the units in Blender.
Anyway decimals numerical values will be automatically
converted to the corresponding value according to the set
scale.
For example, if the scale is set in meters, the value .1 will be
automatically converted in “10cm”.
Or you can operate in the opposite way. Blender recognizes the
values “m” (meters), “cm” (centimeters), “km” (kilometers), "mm”
(millimeters), etc.; it is therefore possible, without making a
conversion calculation in mind, type directly “10cm” or “10 cm”.
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2.2. Start Blender

At startup, Blender comes (if enabled the option of preference)
with a splash screen with a default configuration of the windows.

fig. 37 splash screen

In the splash screen, you can choose the interaction
configuration from the drop-down menu, call up recent files,
retrieve the last open session (Recover Last Session) or visit some
online link.
In the upper side the version with the date of release is shown.
Clicking outside of this window, the window closes and Blender
will present itself in its default configuration.
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2.2.1. Blender interface and basic settings
Blender has been known for a good but difficult software for
years because of its indecipherable GUI.
The interface was still almost the same of the initial versions up to
version 2.49 indeed, that is designed primarily for developers and
not for users.
With version 2.5, Blender got a revolutionary restyling, which
made its user interface something very clear, understandable
and user friendly.
The latest 2.7x version (which this volume refers to), the interface
has been further improved with the introduction of several tabs
on the Tools Shelf bar, as we shall see later.

fig 38 default GUI

As seen, the Blender interface can be customized, as in many
commercial programs, to suit your needs and according to the
working areas.

55

For this reason Blender already provides some layout presets that
allow you to use the interface for modeling, animation,
compositing, game engine, etc.
Let's see in detail how the default interface is structured.
The default layout is divided into five fully customizable windows.

2.2.2. The Info header

fig 39 Info header

The horizontal upper window is called Info, Info editor or Info
Header. It is composed of a header and a gray area, generally
minimized.
The header shows some drop-down menus: File, Render,
Window, Help, Screen Layout, Scene and Render Engine; and an
information line.

a) File
The File drop down menu contains all operations relating to the
imported file, or to import.
In particular:
- New (CTRL + N) creates a new default blank project;
- Open (Ctrl + O) opens the existing file;
- Open Recent (SHIFT + CTRL + O) allows you to open a file
from the recent file list;
- Revert reloads the current file;
- Recover Last Session allows the recovery of the last
unexpectedly closed session;
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- Recover Auto Save restores the last saved version of a
file;
- Save (Ctrl + S) saves the project with a *.blend extension;
- Save As ... (Shift + Ctrl + S) saves the project with a
name;
- User Preferences… (CTRL + ALT + U) retrieves the window
of preference previously analyzed;

fig 40 il menu a tendina File

- Save Startup file (CTRL + U) saves all current settings:
installed or open Addons, positions and size of windows,
the objects in the scene, the entered numerical values,
preferences, and changes made in a template file will
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-

-

-

become the default file opening program. Caution is
recommended in the use of this very useful and
important function;
Load Factory Settings restore the default values with the
default factory settings;
Append and Link allow you to import or connect to an
open file the contents of another file. The shortcut of the
two functions are CTRL+ALT+O and SHIFT+F1 respectively;
Import allows you to load models from other compatible
formats created with other modeling software;
Export saves the project in a compatible format with
other software;
External Data retrieves and manages the files directly
related to the running files (for example, textures and
videos). Simply insert in the opened browser the path of
dissociated files;
Quit (Ctrl + Q) closes Blender.

b) Render
The Render menu manages the tools for the rendering engine.
In particular:
- Render Image starts the rendering process of a static
image (also with the shortcut F12);
- Render Animation starts the rendering process of an
animation (also with CTRL + F12);
- OpenGL Render Image and OpenGL Render Animation
start rendering in OpenGL mode, if supported;
- OpenGL Render Option opens a submenu by managing
OpenGL's Preferences on Antialiasing and Transparency
(Alpha);
- Show / Hide Render View shows or hides the rendering
window during the process (ALT + F11);
- Play Rendered Animation launches the animation after
the rendering process (also with CTRL + F11).
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fig 41 the Render drop-down menu

c)

Window

This menu manages the current interface windows.
s.
- Duplicate Windows duplicates the entire
e
opened
project into a new Blender window (CTRL + ALT + W);
- Toggle Window Full screen maximizes Blen
nder hiding the
top bar of the operating system (ALT + F11)
1);
- Save Screenshot is a shot of the entire workspace
w
and
save the files in a specified folder in the b
browser (Ctrl +
F3);
- Make Screen cast start a video capture clip
c of the work
area and saves it at the end in a /tmp fold
lder. To start the
operation you can also type ALT + F3, whi
hile click on the
CAPTURE button that appears in the head
ader of the Info
window is necessary to stop it. When you
u start this useful
operation a semi-transparent circle will appear
a
around
the cursor that will show the mouse position
p
during
playback video;
- Toggle System Console shows the Ble
Blender starting
command lines into a Shell window.
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fig 42 the Window drop-down menu

d) Help

fig 43 the Help drop-down menu

tion sites
The Help window contains the links to all Blender Foundatio
for manuals, commands, and other dedicated functions.
The Splash Screen launches and redisplays the splash wind
dow.
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e) Screen Layout

fig 44 the Screen Layout menu

fig 45 the Screen Layout set to Animation

This window contains some common configuratio
tions (or Layout)
of the work areas in Blender. Default is the starting c
configuration.
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Of course, setting a different configuration and then saving in
Save Startup File will open Blender in the new configuration until
the next modification.
You can add new windows and panels configurations by
clicking on the “+” button and typing the desired name, or
delete a configuration by clicking the “X” button, both placed
on the right of the drop down menu.
Once a configuration is cancelled, it will be impossible to
recover it.

a) Scene
The Scene menu lets you create different scenes inside the same
*.blend work files, starting from the main one. By clicking on the
“+” button, you will see a drop down menu where you can
specify which elements are to be duplicated in the new scene,
for example, only the settings, rather than the entire scene ( Full
Copy). The scenes in this last case will be completely
independent.
This workflow is fundamental in Blender because it will be easier
to manage in the same project, for example, views and different
illuminations, rather than modified versions with colors and
materials, or the presence or absence of objects.
To delete a scene, just click on the button “X” (on selected
scene).

fig 46 the Scene drop-down menu
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b) Render Engine
This menu is used to select the rendering engine to be used in
the current project.
Blender Render is the default render engine.

fig 47 the Render drop-down menu

c) The info/statistic line
This line provides all the statistics and information such as objects
and elements in the scene.1From left to right: the Blender used
version, the number of vertices and faces of the selected object,
the number of triangulated surfaces, the number of objects in
the scene in relation to the selected objects, the number of
selected depending on the total lamps, the memory occupied
by the file, the name of the active object.
While in Edit Mode (as discussed below) specific statistics will be
activated: the number of vertices, edges, faces and object
name.

fig 48 the info/statistic line
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2.2.3. The 3D View editor
The wide central window is called 3D View, where the actual 3D
solids construction and modeling take place.
On opening, by default, it displays a cube, a light and a camera
arranged on a grid which is parallel to the Cartesian axes x (in
red) and y (in green).
Below, on the left side, the set of three axes x, y, z, respectively, in
the colors red, green and blue is represented and oriented
according to the current view.
At the top, on the left side as well, a string in white informs you
about the type of display (perspective or isometric) and the
current units.
Two vertical bars (one right and one left), called Sidebars,
contain information and tools on the project and on selected
objects.
In particular, the left sidebar is called the Tools Shelf and includes
all the necessary tools for creating and basic modeling.
The right sidebar, called Properties bar, provides the information
and properties of the objects in the scene and the 3D view itself.
Since we have not yet discussed the specifics of the object types
and methods, describing in detail all of the Sidebar feature may
be difficult and not in line with the method used in this book.
We prefer therefore briefly describe the two sidebars and deeply
discuss on the details of their features with clarifying examples in
a second time.
By default, the Header of the 3D view is placed horizontally at
the bottom of the window.
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fig 49 the 3D View Header

From left to right, just after the 3D View icon, the View menu
shows all the functions related to the current view.

fig 50 the View menu
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-

Toggle Fullscreen Area (ALT + F10) maximizes the size of the3D
view in full-screen;
Toggle Maximize Area (CTRL + UP ARROW) maximizes the
3Dview in Blender window (CTRL + DOWN ARROW to restore);
Toggle Quad View (CTRL + ALT + C) divides the work area
into4 equal parts and shows the current scene from the 4
main views (TOP, FRONT, RIGHT and PERSPECTIVE). This option
is useful when you need to control the modeling process both
in the orthogonal views and three-dimensional view;

fig 51 Quad View

- Duplicate Area into New Window duplicates the 3D view with
an exact clone;

- Animation playback (ALT + A) runs the animation;
- View All (Home key) makes all the objects in the scene visible;
- View Selected (. NUM) maximizes and focuses the view on
the selected object;

- View Global / Local (/ NUM) maximizes and focuses on the
-

selected object, hiding all the others. Repeating the
operation returns to the original view;
Show All Layers turn on all layers;
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- Render Border (CTRL + B key with the mouse drag) creates a
-

box selection that will define the area of pre rendering of the
scene or the current view;
Zoom Border (SHIFT + B and dragging) performs an automatic
zoom to the defined area;
Clipping Border (ALT + B, and dragging) automatically shows
only the selected area. Pressing ALT + B again will restore the
previous conditions;
Allign View opens a drop-down submenus, from which you
can chose some other options:
• Align View to Active shows another submenu from which
you can enable the default views, even with some of the
NUM keys:
7 NUM
Top view
CTRL + 7 NUM
Bottom view
1 NUM
Front view
CTRL + 1 NUM
Rear view
3 NUM
Right view
CTRL + 3 NUM
Left view
5 NUM
Split from orthographic
to perspective and vice
versa
4, 6 NUM
horizontal rotations of 5 °
of the view
2, 8 NUM
vertical rotations of 5 °
of the view
0 NUM
Active Camera view
CTRL + 0
Set object as Active
Camera
• Center Cursor and View All centers the view to the3D
cursor and displays all objects;

• Allign Active Camera to View sets the current view as the
camera view, or in other words applies the orientation and
location of the current view to the active camera (ALT +
CTRL + NUM 0);

• Allign Active Camera to Selected automatically frames
the selected object with the active camera;
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• View Selected (. NUM) maximizes and focuses the view on
the selected object;

• Center View to Cursor centers the view in the 3D view so
that the cursor is at the center of the viewport;

• View Lock to Active (SHIFT + . NUM) centers the view on
the selected or active object;

• View Lock Clear (ALT +. NUM) restores the view from the
previous step.

-

Navigation shows the main navigation methods (orbit, pan
and zoom);
View Persp / Ortho (5 NUM) automatically switches from
perspective view to the isometric one;
Cameras opens a submenu with two entries that manage
camera view:

 Set Active Object as Camera (CTRL + NUM 0) means that
the selected camera becomes the active one, whose
view can be displayed with 0 NUM key;

 Active Camera displays the view of the active camera (0
-

-

NUM).
The next 7 voices select the default views with the
combination of the NUM keys (the same as Allign Active View
but without SHIFT key);
Tools Shelf opens and closes the Tools Shelf Bar on the left (T);
Properties opens and closes the Properties Bar on the right
(N).

Below, in the Select menu shows all the commands related to
the selection of the objects and the geometric elements that
compose them.
The items in this menu change depending on the current mode
(Object Mode and Edit Mode). The entries concerning the Edit
Mode will be analyzed in detail below, in the “Mode” chapter
and in particular in the Edit Mode section.
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NOTE: All of Blender menu items gene
nerally change
depending on the current mode. E.g. in Scu
culpt Mode, the
header of the 3D view menu completely
ly changes into
other dedicated items.

Let’s see in detail the entries for Object Mode:
-

-

Select Pattern ... allows you to enter a string for
fo the selection
of objects in the scene. For example * selects all
al objects;
Linked (SHIFT + L) selects objects by grouping
g
type
criteria(object data, material, texture, pa
article system,
libraries, etc.). it is a useful feature if you n
need to select
objects of a specific type;
Grouped (SHIFT + G) selects the objects in the scene
according to a predefined grouping pattern;
Select Camera select the active camera;

fig 52 Select menu in Object Mode
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-

-

-

-

ws you
Select All by Type opens a drop-down menu that allow
to select all objects which belongs to a specific ca
ategory
(mesh, curves ...);
or more
Select All by Layer select all objects placed onto one o
specific layers;
Mirror (SHIF + CTRL + M) selects any objects mirrored by the
selected ones;
roup of
Random make a random selection between a gro
objects in the view. You must specify in the bottom reg
egion of
the Tools Shelf the percentage of selection using the slid
lider;
Invert (Ctrl + I) reverses the current selection;
ts in the
Select / Deselect All (A) select or deselect all objects
scene;
circular
Circle Select is a useful tool to select objects using a c
brush, resizable with WM. By typing C and then adjusti
sting the
size of the circular brush you can select objects by clicking
c
with LMB (MMB to deselect). To end the selection, typ
ype ESC
(or RMB);
Border Select (B) is the most common method of sele
election,
using the rectangular selection by dragging LMB. This
T
will
create an area within which all objects will be selected
d.
NOTE: Selection and active objects. When you sel
elect an
object, its outline is colored with light orange by d
default,
indicating that it is the ACTIVE object, on which to p
perform
basic editing actions. In a multiple selection (m
(multiple
objects), only the active one will have the edge in light
orange, while other selected objects will have the
e edges
colored in dark orange. In a multiple selection JUS
UST ONE
OBJECT could be active.

Other selection and de-selection methods
You can select or deselect multiple objects by SHIFT + LMB
L
on
them, one by one.
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In a multiple selection, the last object selected will
ill be the ACTIVE
one. On that list, you can simply change act
ctive object by
clicking the object again while holding SHIFT.
In the Add menu (SHIFT + A), you can enter all the
e major objects
in the scene.

fig 53 Add menu

SHIFT + A within the work area will open a drop do
own menu with
the same options.
ou’ll find all the
In the Object menu (while in Object Mode) you
controls that manage the operations on selected
d objects in the
scene.
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The menus shown while in Edit Mode will be analyzed in detail in
the related chapter; let’s now analyze the controls in Object
Mode.
-

-

-

-

-

-

-

Convert to (ALT + C) allows you to convert a mesh to curve
and vice versa;
Hide (H) shows or hides the selected object or objects;
Hide Unselected (SHIFT + H) allows the inverse function,
namely to hide what is not selected; while Show Hidden (ALT
+ H) shows previously hidden objects;
Move to Layer (M) moves the selected object or objects on
another layer. Simply select the desired Layer once activated
the command;
Transfer Mesh Data Layout opens a window, once selected
two or more objects (one active), where you can specify
which data to transfer from the active to those selected;
Transfer Mesh Data (SHIFT + CTRL + T) transfer the vertex or
bevel data from the active object to the other selected ones;
Join (CTRL + J) combines two or more object in a single mesh;
Game opens a submenu in which you define to copy, add or
delete the active object properties and data in the game
environment;
Quick Effects quickly assigns to the active object a volumetric
effects or physical behavior, such as: fur, explosion, smoke,
fluid;
Constraints manages chains, groups or parent relations of the
active object, and in particular:
 Add Constraint (with Target) (SHIFT + CTRL + C) opens a
window in which to assign to the active object a relations
with other objects or simulations;
 Copy Constraints to Selected Object, in a selection, copy
the relations of all selected objects from the active one;
 Clear Object Constraints (CTRL + ALT + C) deletes all
relations assigned to the active object.
Group manages objects grouping, not to be confused with
Join as each object will remain the owner of its geometry,
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internal relations and properties, but it will be linked to others.
Group opens a submenu:
 Create a new Group (CTRL + G) groups the selected
objects;
 Remove from Group (CTRL + ALT + G) removes the
selected object from one specific group;
 Remove from All Groups (SHIFT + CTRL + ALT + G)removes
the selected object from all groups which it is linked to;
 Add Selected to Active Group (SHIFT + CTRL + G) add the
selected object to the group that contains the active
object in the scene;
 Remove Selected to Active Group (SHIFT + ALT +
G)removes the selected object from the group, which the
active object is in.
-

-

Track launches Tracking-related commands (we will discuss
them later);
Parent manages the functions of parent/children relations
between objects (we will discuss them later);
Make Single User makes the selected objects data unique
and connected to itself only;
Make Local (L) creates a data library related to the selected
object in the current file;
Make Dupli Face converts the selected object in a two-side
distance;
Make Links (CTRL + L) opens a submenu where you can
choose what to link or copy (materials, data, modifiers,
animations, groups) from the active object on the other
selected objects. To do this you must select the objects on
which you have to copy the data, then (while holding SHIFT)
select the one to copy these data from, type Ctrl + L and
then choose the type of information to be copied (or
connect);
Make Proxy (CTRL + ALT + P) adds an Empty object which
locally assign the object data on;
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-

-

-

-

-

-

Delete removes the selected object or objects. You need to
confirm;
Duplicate Linked (ALT + D) creates an instance of the original.
It is a useful function in the case of identical objects still
subject to change in Object Mode. The changes made in the
original geometry (in Edit Mode) will be automatically applied
to all instances;
Duplicate Object (SHIFT + D) creates an exact copy,
completely independent from the original;
Animation opens a submenu which allows you to control the
main animation functions also from the 3D view:
• Add Keyframe (I) adds a keyframe to a specific
parameter in a given frame; Delete Keyframe (ALT + I)
eliminates an existing keyframe on the selected
parameter;
• Clear Keyframes removes all keyframes on the selected
object;
• Change Keying Set (SHIF + CTRL + ALT + I) changesthe
settings of the active keyframe;
• Bake
Action
definitely
applies
the
keyframed
transformations assigned to the selected object;
Snap (SHIFT + S) opens a submenu in which you can find
summarizes the snap functions (better explained in the
following chapters);
Apply(CTRL + A) definitely assigns to the selected object the
transformation made in Object Mode. This opens a
dropdown menu from where you can choose whether to
apply location, rotation, scale, rotation & scale;
Clear restores the original Location(ALT + G),Rotation(ALT
+R),Scale (ALT + S), Origin (ALT + O) settings of the selected
object;
Mirror lets you to mirror an object according to the mouse
position (CTRL + M), or according to x, y or z axes;
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fig 54 Object menu in Object Mode

-

Transform allows you to perform the three main
transformations: Grab (G), Rotation (R), Scale (S). The
command may be followed by keyboard entries such as the
x, y or z direction and the numerical value. For example, to
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-

move the object by 2 meters in the negative X direction
simply type “G X 2 -” (or “- 2”);
Undo History(CTRL + ALT + Z) shows a dropdown menu which
lists the last used commands;
Redo (SHIFT + CTRL + Z) restores the last cancelled operation;
Undo (Ctrl + Z) cancels the last operation.

The next drop-down menu, called Mode Menu (Object Mode is
displayed by default), allows you to access the various working
modes, which are:

fig 55 Mode menu

-

-

-

Object Mode, which allows you to modify the whole selected
object, without editing its “internal” geometry;
Edit Mode, in which you can modify the single geometry
elements of the object (vertex, edges and faces), using
specific geometry tools;
Sculpt Mode, which allows you to literally sculpt the shape of
the object with customizable brushes which make the
workflow similar to a real clay sculpting method;
Vertex Paint, which allows you to paint some vertices, in order
to assign them specific operations;
Weight Paint, which assigns a weight to each painted vertex;
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-

Texture Paint, which allows you to paint textures applied on
the selected object directly in the 3D Viewport.

With the TAB key you can quickly switch between Object Mode
and Edit Mode and vice versa; CTRL + TAB to switch between
Object Mode and Weight Paint Mode.
There are two other modes that are available only with specific
objects:
-

Particle Mode, which contains tools to manage the particle
systems;
Pose Mode, dedicated to the armor posing mode. You can
toggle this mode with the Weight Paint mode clicking CTRL +
TAB.

We will go into detail later, after learning introductory concepts.

fig 56 visualization styles

The next menu is the Viewport Shading Menu and displays all the
objects in the 3D view in six different ways.
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-

-

-

Bounding Box displays a box corresponding to the maximum
object size. This method is useful in case of very dense
geometries and “heavy” scenes;
Wireframe displays transparent wireframe object with only
edges visible. This display style is very useful to understand the
totality of the objects geometry and to select parts which
could be hidden by foreground objects;
Solid displays the object as a solid (not transparent). In this
case you can only select visible objects (or its components);
Texture makes applied textures visible in the 3D view. Useful to
check if UV mapping was properly assigned or not;
Material provides more complete information on the material
assigned to the objects, such as reflections and
transparencies;

fig 57 visualization styles: 1: Bounding Box; 2: Wireframe; 3: Solid; 4: Texture;
5:Material; 6:Rendered

-

Rendered allows you to see a preview of the rendered scene,
according to the Preview Sampling resolution set in the
Render panel of the Properties window. Useful to preview the
final result without the need to launch long rendering
processes. SHIFT + Z to toggle between Solid and Rendered
view.
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Z key allows you to quickly toggle between the two most used
visualization styles, Solid and Wireframe; ALT + Z to toggle
between
Solid and Texture view.
The next button Pivot Center for Rotating / Scaling will be
analyzed later through practical examples.
It is used to define the center (Pivot) point for a transformation.

fig 58 Pivot Center for Rotating / Scaling button

You can set as Pivot point the active element of a selection
(center of gravity); the middle point of an object, of a selection
of objects or elements; individual center of gravity of all the
selected objects or items; the center of gravity between several
objects; the 3D cursor; the center of gravity of the Bounding Box,
if enabled.

fig 59 Transform Orientation menu

The following buttons are used to select the object manipulators,
used to manually operate on the selected object or its geometry
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performing the three main transformations: move, rotate and
scale.
The first of the five buttons enables/disables the manipulators.
The second one (a small arrow) adds the translation manipulator
to the selected object (displayed as three colored arrows)
centered on the pivot point and aligned along the three
reference axes x , y and z. To move the object along an axis just
click on the corresponding arrow and drag it forward or
backward. To freely move the object, simply click and drag the
white center circle.
The third button (a little arc) adds the rotation manipulator to the
selected object (displayed as a set of three colored rings)
centered on the pivot point around the three reference axes x ,
y and z. To rotate the object around an axis just click on the
corresponding ring and drag it clockward or counter-clockward.
To operate free rotation, simply click and drag on the white
central circle.
The fourth one (a line with a square at the end) adds the scaling
manipulator to the selected object (displayed as a set of three
axes with handles at the top) centered on the pivot point and
aligned along the three reference axes x , y and z. To scale the
object along a axis, just click and drag on the corresponding
square. To make a global scale, simply click and drag the white
center circle.
In all the three cases, the manipulators use the conventional
axes color (red = x , green = y , blue = z ).
You can enable all three buttons simultaneously with SHIFT + LMB
on the specific icons; it will display all of the three manipulators
on the selected object.
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The fifth button (with the text Global by de
efault), named
Transform Orientation, opens a drop down menu
u that allows to
choose the reference axis system: Global (referred
ed to the whole
scene), Local (referred to the selected object)
t), Gimbal (i.e.
according to the active Rotation Mode, with Z axis fixed on
Global z-axis while X and Y pointing object x and
nd y local axis),
Normal (perpendicular to the selected face/edg
dge) and View
(referred to the current view).

fig 60 the three Manipulator handles centered on the Pivot pointt of the Cube

Like other image editing software or CAD drawing
ing, Blender also
allows to group objects in Layers.

fig 61 Layer Selector

The layer system helps you to properly manage and
an design your
object distribution on the scene.
Grouping objects by type, material, color or functio
tion can solve a
lot of problems and, if necessary, to lighten up the
th scene from
unnecessary objects at some stage simply by
y turning off a
specific layer.
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fig 62 Move to Layer option

Blender has 20 layers each represented by a box. In the next
version 2.8 the layers will be removed and replaced with the
Collections into the Outliner. Follow next Upgrades.
Layers which contain at least one object are displayed as a box
with a grey circle (in the Layer selector), while boxes with the
darker gray background represent active layers, meaning that
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the objects grouped in them are displayed in the scene and
eventually rendered.
The box with the yellow circle represents the layers which
contains the active object.
To move an object or objects in a specific layer simply select
them from the Object menu and choose the option Move To
Layer (M), then select the box representing the layer target.
Alternatively you can type M and the number from 1 to 0 to
move the selected object directly to any layer within the first 10.
If the Layer Management addon is enabled, layers can be
managed from the Tools Shelf, where you can name layers, turn
them off/on in the 3D view or in the render, and many other
options.
If the button layers lock is enabled (as it is by default), any
changes to the layer visibility of the current view also take place
in all the 3D views with layers lock enabled.

fig 63 Layers lock button

On the right of the layers icons you can find the Proportional
Editing options, displayed as a button with a gray ball inside
(meaning it is disabled – by default). LMB on this icon (or press O
key) to enable it (the grey ball turn to blue): a drop-down menu
named Proportional Editing Falloff appears on his right.
This menu is used to control the proportional influence of the
transformation operations (move, rotate and scale) on the
nearby objects (or elements if you are in Edit Mode) according
to the selected distribution method.
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fig 64 Proportional Editing falloff

While in Proportional Editing mode, once a transformation
command is activated a white circle appears on the Pivot point,
representing the width of the influence area; scrolling the mouse
wheel (WM) the white circle will scale and the transformation will
be applied to all the elements within it, according to the
selected Proportional Editing falloff.
You can choose among Smooth, Sphere, Root, Sharp, Linear,
Constant and Random distribution.
The icons to the left to the individual menu items explain the
effect applied.
The Snap icon (displayed as a magnet) is a powerful tool used to
control the transformation operations, snapping object or mesh
elements to various types of scene elements during the
transformation itself, according to a predetermined logic.
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fig 65 Snap menu

The last two buttons launch the rendering or animation in
OpenGL mode (Open Graphics Library), a widely used platform
for video games and especially in the Unix environment.

fig 66 OpenGL Render and Animation buttons

2.2.4. The 3D View Sidebars – basic knowledge
The Sidebars tools, features and controls may change according
to the selected object, the current Mode type and the enabled
Addons.
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fig 67 Tool and Properties Bar

A) Tools Shelf
creation
In the Tools Shelf you can find all the transformation and cr
tools, relations management tools, physic and other tools.
ls. These
may change depending on the current mode of the se
selected
object, enabling different options.
It is divided into two main regions: the upper one co
contains
several tabs, while the lower one is active during sspecific
commands.
Let’s briefly describe the default tabs in the upper region:
-

-

objects
Tools contains all the transformation controls for o
geometries. The parameters and panels may c
change
depending on the mode and type of objects;
Create(SHIFT + A) allows you to insert new objects
ts in the
scene;
Relations manages the parent/child relationships be
etween
objects in the scene;
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-

Physics contains the main controls for the physic simulation;
Grease Pencil contains the basic tools to draw freehand in
the 3D view.

fig 68 the Tools Shelf in Object Mode (left) and Edit Mode (right)
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More panels and tabs can be added by enabling specific
Addons, such as the 3D printing tools or the Layer Management,
previously described.

B)

Properties Bar

The Properties Bar, not to be confused with the Properties
Window (or Properties Editor), displays all the properties of the
selected (or active)object, View options, Shading options, 3D
Cursor location and other functions which will be briefly shown
below, aiming to be detailed in the following chapters.
All properties are divided into specific panels (not necessarily in
the order described below):

- Item is a text box that provides information on the name of
the selected object. This can be changed by clicking within
the text field. Automatically the name will be updated in the
objects list of the Outliner and in the Object panel of the
Properties window.

- Transform groups the location, rotation, scale and size
properties to the selected (or active) object. While in Edit
Mode, the panel can also show the chamfering information
of the selected Vertex or Edge (Mean Bevel Weight, Bevel
Weight and Mean Crease) if a geometry modifier is applied
(such as Bevel or Subdivision Surface modifier). These
parameters can be directly edited into the specific counters,
or using shortcuts (as discussed below) or manipulators;

- Grease Pencil, which contains information about the brush
and pencil sets, is used to draw directly in the 3D view or on a
mesh object;
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fig 69 the Properties Bar in Object Mode (left) and Edit Mode (right)

- View provides information on the current view such as the
virtual camera lens angle and the clipping starting and
ending distance; you can lock all navigation operations
within the 3D view on a specific object (Lock To Object) to be
selected from the pull down menu list, or on the 3D cursor
(Lock to Cursor); with a Camera view active, you can lock
the navigation operations in order to be applied to the
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Camera view (Lock Camera to View); you can select the
active camera (Local Camera) and render the limits of a
selection in the 3D view (Render Border);

-

3D Cursor provides the 3D Cursor Location, referred to the
origin of the Global Axes;
Display, where you can check/uncheck what to visualize in
the 3D view and in particular:
• Only Render, if enabled displays in the 3D view only what
will be actually rendered;
• World Background, in enabled shows the color of the
background set for the current scene;
• Outline Selected displays a colored outline of the selected
object(s). The default colors are light orange for the active
object and dark orange for the other selected objects;

• All Object Origins if check, displays the origin of all objects
in the scene instead of the active object only;

fig 70 predefined Matcap virtual shaders

• Grid Floor enable/disable the visibility of x, y and z axes
and of the grid on the XY plane in the 3D view; you can
also manage the lines number, the size and the
subdivisions of the grid. Toggle Quad View automatically
split the 3D View in 4 regions representing the User
Perspective view, a Top Ortho view, the Front Ortho view
and the Right Ortho view.
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-

-

-

Shading is a panel that manages the shading of 3D objects in
the scene. There are three options to check:
 Textured Solid which forces the display of a texture, if
assigned, even in Solid shading mode;
 Matcap assigns a predefined shader to all the objects in
the scene, it is very useful to better understand the
geometry of the meshes, especially while sculpting. These
shaders are only virtual and do not effect the actual
object material;
 Backface Culling, in non-solid surfaces, makes the back
faces (according to the face normal orientation)
transparent (not in Rendered shading view);
Motion Tracking contains some helpful parameters for the
motion tracking system used for animations;
Background Image will be widely analyzed later with
practical examples. Essentially it allows you to load one or
more images (also called blueprints) as background of a
specific view (or all of them) replacing, scaling and rotating
them to fit your need in order to use them as references for
your model;
Transform Orientation is the same option previously described
in the Manipulator icon set of the 3D view header.

2.2.4.

The Timeline editor

fig 71 the Timeline window

The use of the Timeline is manifold. It is used to reproduce the
simulation of physical effects applying transformations in a
specific span of time; it is used for animations, video editing and
post production.
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fig 72 the frames string and zoom button

The Timeline looks like a very simple window: a main are
rea with
vertical black and grey thin lines representing the framess and a
green vertical cursor (representing the current frame),
), which
proceeds frame by frame, second by second as the anim
nimation
goes by.
Below the main area you can find a horizontal bar whe
here the
frames’ numbers are indicated and two small dark grey
y circles
are placed (one on the right and the other on the left
ft of the
frames bar), which are used to zoom in or out the disp
played
range of frames, simply by LMB dragging to the right/le
/left the
circles.

fig 73 Timeline header

n which,
Below the frames bar, the Timeline header is located, in
from left to right the following buttons and menus are place
ced:
-

The Timeline editor icon (a clock icon);
View menu, where you can find the following options:
• Toggle Fullscreen Area (ALT + F10) that sets the Timeline
Ti
window to full screen;
aximizes
• Toggle Maximize Area (CTRL + UP ARROW) that ma
the Timeline area into the Blender window (CTRL + DOWN
ARROW to restore);
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fig 74 the View menu of the Timeline





Duplicate Area into New Window that d
duplicates the
Timeline window in a new Blender window;
Bind Camera to Markers (CTRL + B) will link
ink the selected
camera on the active markers;
Cache that displays the cache of the different
d
physic
simulations applied to an object;

fig 75 the Cache menu




Only Keyframes to Selected Channels iff checked only
considers keyframes for the selected object;
t;
Show Frame Number Indicator displays the
e current frame
number in a green box on the bottom righ
ht of the green
slider (vertical line) in the Timeline main area
a;
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View All adjusts the zoom rate in order to show the full
active frame range in the Timeline window;

fig 76 frame number on the Timeline slider

fig 77 the Marker menu of the Timeline





Lock Time to Other Windows allows you to synchronize the
time of all the windows on the selected frame in the
Timeline;
Show Seconds displays the seconds together with the
relative frame number (“3+12” means that the current
frame is the 12th after the second number 3 of the
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animation) in the green box placed on the bottom right of
the green slider (vertical line) in the Timeline main area;
-

the Marker menu allows you to manage markers in the
Timeline. The markers must not be confused with the
keyframes, which will be analyzed later. They are used to
insert a visual mark in order to point out any useful information
or note about animation sections or specific events; they can
be shown on the windows that manage “time events”
(Timeline but also Graph Editor, Video Sequencer and Dope
Sheet). To insert a marker in the current frame just type M or
choose Add Marker from the Marker menu. Let’s see other
options:











-

Jump to Previous Marker immediately jumps to the
location (frame) of the previous marker (according to the
selected one);
Jump to Next Marker jumps to the location (frame) of the
next marker (according to the selected one);
Grab / Move Marker allows you to translate or move the
selected marker. It is the same to dragging with the
mouse;
Rename Marker (CTRL + M) allows you to name (or
rename) a marker;
Delete Marker (X) deletes the selected marker;
Duplicate Marker To Scene... allows you to copy the
selected marker into another scene;
Duplicate Marker duplicates the selected marker into the
current scene;
Add Marker (M) adds a new marker to the current frame.

The Frame menu contains all the information and tools to
manage the frames:
• Auto-Keyframing Mode allows you to choose between the
types of automatic keyframes insertion, Add &Replace or
Replace;
• Set Start Frame (S) sets the current frame as the first frame
of the animation preview;
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•
•

•

Set End Frame (E) sets the current frame as the last frame
of the animation preview;
Set Preview Range (P) allows you to graphically select few
frames (with a box selection method) to play as an
animation preview;
Clear Preview Range (ALT + P) reset the animation
preview to the full animation range.

fig 78 the Frame menu

-

The Playback menu shows a check list of the elements to be
played during dragging operations in the Timeline.
• Audio Scrubbing allows audio channels to be listened
during manual drag in the Timeline;
• Audio Muted turns off audio playback;
• AV-Sync plays back and sync with audio clock;
• Frame Dopping causes the frames to be dropped if the
frame display is too slow;
• Clip Editor updates the Movie Clip Editor during playback;
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fig 79 the Playback menu








Node Editor updates the nodes in the Node
de Editor during
playback;
Sequencer Editor updates the Seque
uencer during
playback;
ring playback;
Image Editors updates the Image Editor durin
Property Editors updates in real time the
e values in the
Preferences editors during playback;
aph Editor and
Animation Editors updates Timeline, Grap
Video Sequencer Editor during playback;
All 3D View Editors updates Timeline and 3D
3 View during
playback;
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Top-Left 3D Editors updates the Timeline during playback if
Animation Editors and All 3D View Editors are enabled.

The next menus and controls on the Timeline header are:
-

Range Control buttons:
 Use Preview Range if enabled uses an alternative
start/end frame range for animation playback and
OpenGL renders instead of the Render Properties star/end
frame range;
 Lock Time Cursor to Playback Range if enabled doesn’t
allow frame to be selected with mouse outside of the
frame range in the Timeline main area.

fig 80 Range Control buttons

-

Frame Control Counter:

fig 81 Frame Control Counter






Start and End define the start and end frame of the
animation range (corresponding to the range defined in
the Render Properties tab);
Frame is the number of the current frame and allows you
to jump directly to the typed frame;
The playback buttons allow you to start, stop and move
through the animation. From left to right: jump to the
beginning; Fast backward; play backward; play / pause
(ALT + A) ; Fast forward; jump to the end.

fig 82 the playback buttons
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-

The Sync Mode dropdown menu defines the sync mode (AVSync; Frame Dropping; No Sync).

fig 83 Sync Mode dropdown menu

fig 84 Keyframe Control buttons

fig 85 location counters turning yellow when the I key is pressed

-

Keyframe Control buttons help to manage the keyframes.
Keyframes record a specific information in the selected
frameand playback it during the animation. In Blender you
can keyframe almost any button, counter or value. To add a
keyframe to a frame from a specific info, just type the I key
with your mouse pointer on the selected value. The color of
the box or the button will turn yellow and a yellow keyframe
will then appear on the Timeline as a vertical bar.
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Record (the red dot button) enables/disables the
automatic keyframe insertion for Objects and Bones;
Auto Keying insertion allows you to automatically insert
new keyframes according to the selected Auto Keying
Set.

All animation functions and tools will be discussed in detail in the
following chapters, with tutorials and exercises.

2.2.6. The Outliner editor

fig 86 the Outliner editor

The Outliner editor (or Outliner window) contains the set of
objects, their properties and relations.
The Outliner is divided into two parts: the header, at the top by
default, and the main area in the lower part.
Let’s now analyze the main working area and the way it is
organized.
The structure of the Outliner has a “tree” organization.
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fig 87 Outliner tree structure

The Scene has a general World and a rendering system
organized in Render Layer (as we shall see further on).
Organizing a scene indifferent layers (such as in some other
photo editing software) allows to gain a more precise control on
the various aspects of the final render.
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Some objects may be explored into their sublevels, going into
the specifics of their geometry or properties, based on the object
type.
The small “+” opens the root of an object, containing all data
blocks referring to it, each one with its proper icon or symbol.

The World contains all the objects in the scene, each one listed
in the Outliner tree and represented by a different icon, specific
for each category, followed by its name.
The main root of an object corresponds to its Object Mode.
The selected object or the active one is displayed in the Outliner
with white characters.
Right-clicking (RMB) on an item in the list opens a dropdown
menu, called Outliner Object Operation, in which you can:

fig 88 main root object dropdown menu
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elect Hierarchy;
a) for main root objects: Select; Deselect; Sele
Delete; Toggle Visible, Selectable and Ren
enderable and
Rename;
vel: Unlink (i.e.
b) for objects or properties in secondary leve
disconnecting the material from a mesh), Mak
ake Local; other
secondary functions that we discuss elsewhere
re (Make Single
User, Add Fake user, Clear Fake user, Re
Rename, Select
Unlinked).

fig 89 second level object dropdown menu

Let’s analyze now the Header’s options.
To the very right of the window type icon (a stylize
lized flow chart),
we find the View menu.

- Sort Alphabetically displays objects on the listt in alphabetical
-

-

order;
Show Column Restriction enabled the three c
columns to the
right of the objects list (with the icon of an eye,
e, an arrow and
a camera) – see details below;
Show Active (. NUM) focuses the list on the active
ac
object in
the 3D view;
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-

-

Show/Hide One Level shows the root and all the sub-levels of
all the objects in the list;
Show Hierarchy minimizes the list showing all main roots only;
Duplicate Area into New Window duplicates the Outliner
window in a new Blender window;
Toggle Maximize Area (CTRL + UP ARROW) that maximizes the
Outliner area into the Blender window (CTRL + DOWN ARROW
to restore);
Toggle Fullscreen Area (ALT + F10) that sets the Outliner
window to full screen;

fig 90 the View menu of the Outliner

The Search menu contains two check boxes that will be
explained in the following pages:

fig 91 the Search menu of the Outliner
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-

Case Sensitive Marches Only;
Complete Matches Only.

fig 92 thr Display Mode menu

The Display Mode is a filter for the objects displa
layed in the list,
allowing you to sort i.e. all the scenes, the curre
rrent scene, the
visible layers , etc.
The search input box allows you to type your own
n filter option to
easily find the object you want to select and view the
t
list.

fig 93 the search input box

The three display icons (an eye, an arrow an
nd a camera)
respectively allow you to make the object:
-

Visible/not visible in the 3D view;
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-

Selectable/not selectable in the 3D view;
Renderable/not renderable.

fig 94 the display icons

2.2.7. The Properties editor
The Properties editor (not to be confused with the Properties Bar)
allows you to manage the global properties of the whole
project.
The Properties window is located By default below the Outliner
and is divided into 12 tabs, each one symbolized by a different
icon and all contained in the Properties window’s header, right
after the window type icon (a slider and a counter).

fig 95 the header of the Properties editor

To describe and to analyze all the functions in the Properties
window at this stage would be counterproductive because
many concepts and information we didn’t explained so far
would be required.
It is better to acquire all of the first introductory concepts on
modeling, before going into the details of the Properties window.
We will then briefly review the content contained in the 12 tabs.
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fig 96 Render Properties

-

Render (camera icon) contains all the rendering settings for
still images or animations. It contains the following panels
(may change according to the used render engine): Render
(with render buttons and details and graphic device settings);
Dimensions (frame size and resolution settings); Output
(output file settings); Sampling and Volume Sampling
(rendered image sampling settings); Light Path (light controls
and settings); Motion Blur (motion blur effect settings); Film
(exposure
and
transparency
settings);
Performance
(rendering process optimization according to the installed
hardware); Post Processing (enable/disable internal post
production passes of the rendered file); Bake (the parameters
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to create 2D bitmap images of a mesh object's ren
endered
surface); Freestyle (hand drawing render effect settings
gs).
-

Render Layer contains all the render layers paramete
ters and
settings.

fig 97 Render Layer Properties

fig 98 Scene Properties
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-

Scene contains the current scene settings divided in the
following panels: Scene (Camera and background
information); Units (unit systems settings); Keying Sets
(keyframing settings); Color Management (color settings);
Audio
(audio
settings);
Gravity
(gravity
simulation
settings);Rigid Body World (settings about rigid bodies
physical environment simulation);

fig 98 World Properties

-

-

World contains all the settings about the environment and
background of the 3D scene: Preview (provides a preview of
the background); Surface (background settings); Ambient
Occlusion (ambient occlusion effect settings); Ray visibility
(information and settings on the visibility and the effects of
light in the scene and rendering); Settings (general lighting
and background settings).
Object shows the general properties of the selected object:
the name of the object, Transform (position, rotation and
scaling of the object); Relations (possible relationships with
other objects); Delta Transform (difference in position, rotate
and scale after a transformation compared to starting
values); Transform Locks (enable/disable transformations
locks); Groups (groups settings); Duplication (object
duplication method settings); Relations Extras (parent and
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camera tracking settings); Motion Paths (details and ssettings
on the paths assigned to the movement); Motion Blur (settings
(s
on the trail left by the rapid movement).

fig 99 Object Properties

-

Constraints lets you assign to an object concate
tenation
relationships with other objects, paths, forces, etc.. Some
examples, especially about camera movement
nt and
animations, will be deeply discuss in the following page
es. With
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e of constraints
a drop-down menu you can choose the type
among Motion Tracking, Transform, Tracking an
nd Relationship.

fig 100 Constraints Properties

-

-

n and powerful
Modifiers contains the most useful, common
tools of all the modeling environment Blender.
r. Modifiers add
algorithms to the selected object to deform the geometry
according to specific parameters and functions.
f
The
modifiers will be deeply discuss into the dedic
icated chapter,
detailed one by one, with several practical exa
amples.
Data allows to manage the internal geometr
try data of the
selected object. With a mesh selected, you
u can manage
groups of selected geometry elements (such a
as vertices), to
assign them colors, effects, specific behaviorr o
or particles; or
with curves you can for example set their shape,
sh
thickness
etc. The tab icon may change depending on the selected
object type.

111

fig 100 Modifiers Properties

fig 102 Data Properties
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fig 103 Material Properties

-

Material (another topic we’ll deeply discuss in the following
pages) assigns a material to an object, and
nd manages its
properties.

-

Texture allows you to manage all used texturess and add new
ones to the mesh and/or some of the mod
odifiers; textures
could be procedural (generated by specific
c mathematical
algorithms) or external bitmap files.

fig 104 Texture Properties

-

Particles allows to manage particle system
ms applied to
amesh, which are useful to simulate hair, grass
ss strands, fur or
emission simulations. This topic will be deeply
ly discuss in the
following pages.
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fig 104 Particles Properties

-

Physics finally enables physic components to objects or to the
environment. The list of available components may c
change
according to the selected object. I.e. with a mesh selected
se
the following are available: Force Field (external force
ces such
as wind, vortex, magnetism, etc.); Collision (makes an
n object
subject to collision with another belonging to the physical
p
system); Cloth (simulates the behavior of a fabric,
c, when
applied to a mesh); Dynamic Paint (allows you to
o assign
specific influences on the physical system by painting
g vertex
directly on the mesh); Soft Body (assigns elastic behavi
vior to a
mesh); Fluid (allows to manage fluid simulations);; Smoke
(simulates smoke and flames); Rigid Body (applies rigid
d bodies
dynamics to a mesh, which becomes subject to gravity,
g
collision and breakage); Rigid Body Constraint (se
ets the
influences of physics with other parameters). It is finally
interesting to note how the various physical componen
ents can
interact with each other and with the particle system
ms, such
as the wind can simulate the waving of a flag or m
mess up
hairs. We will discuss the Physics in detail in the fol
following
chapters.
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fig 106 Physics Properties
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2.3. Keyboard shortcuts

The keyboard shortcuts commands are simply obtained by
pushing a button or with a combination of keys on your
keyboard; it helps you to speed up work operations.
Using shortcuts to avoid looking for commands and tools in the
menu is the best way to save your time and optimize your
workflow.
You must then accept (but you’ll soon agree) the idea that
working with two hands is the best approach and that you need
to learn at least the more frequently used shortcuts we'll
gradually know and use.
In any case, all commands can be run either from the specific
menu (or button) in the Blender windows or by its own shortcut .

fig 107 the shortcuts customization in the User Preferences window
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As previously shown in the introduction, you can customize
c
your
shortcuts the Input tab of the User Preferences win
indow (CTRL + A
+ U), although we highly recommend to use the default
d
settings,
for compatibility reasons with other courses or tutor
orial.
All available commands are organized by groupss and
a
functions.

NOTE: You can find a lot of shortcuts scheme
es online.
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2.4. Mouse
system

and

keyboard

navigation

As previously mentioned, the use of the keyboard and shortcut is
essential, but the mouse is the primary tool to navigate the 3D
view, to select objects and elements and to make any
transformation. You can select, move, or orbiting a scene with it.
Let’s see the main mouse functions in the table below:
LBM (RMB by default)
RMB (LMB by default)
MMB and dragging

WM
SHIFT + MMB
CTRL + MMB
SHIFT + WM
CTRL + WM
ALT + WM

Select objects or elements
Pace the 3D Cursor
Orbit the view (pivot point is
specified in the Interface tab of
the User Preferences)
Zoom in or out
Browse freely in the 3D view
(pan)
Dragging the mouse up and
down to zoom in or out
Pan up/down
Pan right/left
Scroll forward/backward the
current frame

These are the main shortcuts that let you quickly switch through
the predefined views in the 3D view:
7 NUM
CTRL + 7 NUM
1 NUM
CTRL + 1 NUM
3 NUM
CTRL + 3 NUM
5 NUM

Top view
Bottom view
Front view
Rear view
Right view
Left view
Split from orthographic to
perspective and vice versa
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4, 6 NUM
2, 8 NUM
0 NUM
CTRL + 0
CTRL + ALT + 0

horizontal rotations of 5 ° of the
view
vertical rotations of 5 ° of the view
Active Camera view
Set object as Active Camera
Set the current view as camera view
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2.5. Selection

As shown before, you can select objects in different ways
ys.
We quickly sum up the main methods and their shortcut:
a) Selection with LMB (RMB by default );
R
by
b) Multiple selection with SHIFT + LMB (SHIFT + RMB
default);
c) Border selection with B
d) Circle selection with C (ESC or ENTER to confirm);
);
e) Lasso selection with CTRL + RMB (CTRL + LM
LMB by
default);
f) Select/deselect all with A;
g) Invert selection with I;
h) Random selection from the Select drop down m
menu in
the 3Dview.
NOTE: These selection methods are valid in eitherr mode
Object Mode and Edit Mode.

fig 108 Border selection (B)
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fig 109 Circle selection (C)

fig 110 Lasso selection (CTRL + RMB)
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2.6. 3D Cursor and Origin (Pivot)

The 3D Cursor is an uncommon tool in almost all 3D modeling
software; actually it can be said that Blender is the only software
to use it among the most important ones.
It is displayed as a white and red sight.

fig 111 the 3D Cursor

Apparently hard to understand, the 3D Cursor is fundamental
because it allows you to operate in many different ways on
objects or in the 3D view.
First of all the 3D Cursor is the exact point in the 3D space where
a new object is added, or more precisely where the Origin of the
new object will be placed.
Managing 3D Cursor and Origin together you will be able to
modify the mass origin of objects, set the center of rotation or
scale, snap objects and other important operations.
To move the 3D Cursor you can simply click anywhere in the
working area of the 3D view with RMB (LMB by default), or type
the coordinates in the 3D Cursor panel of the Properties Bar.
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fig 112 3D Cursor coordinates

You can also assign to the 3D Cursor and Orig
rigin a specific
position in relation to other elements of the scene with
w SHIFT + S.

fig 113 advanced placement options for 3D Cursor with SHIFT + S

The Snap drop-down menu (SHIFT + S) options are:
-

-

-

int (Selection to
move the object’s Origin to the closest grid poin
Grid);
a element or
move the object’s Origin in Object Mode orr an
group of elements in Edit Mode on the 3D Curso
rsor (Selection to
Cursor);
move the 3D Cursor to the active object’s Origin
Or
in Object
Mode or to the selected element or group of elements
e
in Edit
Mode (Cursor to Selected);
move the 3D Cursor to the 3D world’s origin (Cu
Cursor to Center)
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-

move the 3D Cursor to the closest grid point (Cursor to Grid);
move the 3D Cursor to the active object’s Origin (Cursor to
Active).
Similarly, you can assign the object’s Origin a specific position
in relation to other elements or the 3D Cursor himself from the
Set Origin menu (SHIFT + CTRL + ALT + C) in the Tool tab of the
Tool.

fig 114 Set Origin menu

From this menu you can choose where to place the Origin:
- Geometry to Origin moves the mesh geometry around its
Origin;
- Origin to Geometry moves the object’s Origin to the
geometric center of an object's;
- Origin to 3D Cursor moves the object’s Origin to the 3D
Cursor;
- Origin to Center of Mass moves the object’s Origin to the
center of mass of the object.

124

EXERCISE n. 1: PLACE THE 3D CURSOR O
ON THE ORIGIN
AND VICE VERSA
Let’s try to place the 3D cursor on the Origin and v
vice versa with
a simple exercise.
Insert a cube and type the G X 3 sequence (we
e shall see later
the meaning), to move it along the X axis by 3 me
eters.
Now type SHIFT + S and set Cursor to Selected. The
e 3D Cursor will
be placed at the origin of the cube.
Undo the last two steps by typing twice Ctrl + Z.. The cube will
return to the axis origin (original insertion point) wh
hile the cursor
will not move.
With the cube selected Type R to rotate it. Moving
ng the mouse it
will rotate around its origin, which is placed exactl
tly in its center
of gravity.
Press ESC to cancel the operation.
Now type SHIFT + CTRL + ALT + C and choose the
e option Origin
to 3DCursor . The Origin will be placed to the 3D Cursor.
Cu
Now let’s try to freely rotate the cube in the 3D spa
pace by simply
typing R and moving the mouse.
The cube will rotate around its origin placed this tim
time outside of
its center of gravity.
Press ESC to cancel.
With this simple exercise we have seen how the
th interaction
between the 3D Cursor and the Origin is imp
portant to get
different results, depending on the case.
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